Second Language Acquisition in a Content-based Web Building Course

Ronald Murray Scott Dagilis

Submitted in partial fulfillment of the requirements for the Master of Arts in Teaching degree at the School for International Training, Brattleboro, Vermont

August 2002
Copyright © 2002 by Scott Dagilis

The author hereby grants to the School for International Training, permission to reproduce either electronically or in print format this document in whole or in part for library archival purposes only.

Author: __________________________
This project by Ronald Murray Scott Dagilis is accepted in its present form.

Date___________________________

Project Advisor_______________________________

Project Reader_______________________________
To Pamela Sims
Abstract

Content based courses have been shown to provide an effective environment for second language acquisition (Snow, Met and Genesee 1989). In this content based course students learn how to make a website in 48 hours of class time. In doing so, they improve their English in the skill areas of reading, writing, listening and speaking for an authentic need (Sterns 1990). Learners are motivated and enthusiastic about their projects, leading to more success in language acquisition (Gardner 1985). They are given an opportunity to express themselves creatively and artistically using the target language. Graduates leave with a published portfolio that can be accessed world-wide that they can and do continue to build.

This project includes a course manual that supplements the web building course. The manual covers all stages of web development from basic HTML, good website design and usability, storyboarding, using Macromedia Dreamweaver to build the site and Adobe Photoshop to edit and optimize images. It also addresses search engine optimization and registration, and website maintenance issues. It includes step-by-step documentation with screenshots, chapter reviews and exercises, as well as a glossary and tips for teachers. This manual is supported by www.purplesunsetdesigns.com.

Descriptors: English (Second Language); Second Language Learning; Second Language Instruction; English for Special Purposes; Instructional Materials; Textbooks; Computer Uses in Education; Scholastic Journalism.
Preface

Second Language Acquisition in a Web Building Course

In this section I will describe the language learning that is taking place in a web building course I am teaching to upper-level ESL students. They range from ages 23-30 and are mostly Asian (Korea and Japan). The materials project I have created for my IPP is a 70-page manual on how to make a website and supports this course. The course is also supported by my website http://www.purplesunsetdesigns.com/. Examples of the student’s websites can be viewed at http://www.purplesunsetdesigns.com/webcourse.htm.

The course is a month long, 3 hours a day 4 days a week totaling 48 hours. The average amount of homework is about one to two hours a day. Feedback on the course has been very positive, and although the ostensible purpose of the course is to create a website, significant English learning takes place on many levels in this content based course.

Language acquisition in this course includes the four skills of listening, reading, writing and speaking in an environment where the purpose of communication is real and not artificially induced. My course also encourages community-building and offers a chance for students to publish on a world-wide scale via the Internet.

In my usual ESL conversation classes, I always have the challenge of trying to create as authentic a learning environment as possible. This concern has been raised by Strasheim (1976) and Slager (1978). The difficulty is that my students, most of who are from Asia, have often studied English for several years in an environment that tends to enforce the idea that the study of the language is a kind of end in itself. This is achieved through the focus on testing, memorization, emphasis on accuracy, and the dependency on artificial conversations, environments, textbooks and other materials that deconstruct the language. This hyper-awareness of the focus on accuracy of the language is still with them in an ESL classroom. Also, in my regular ESL classes students would often express concern that their English was either not improving, or getting worse. Part of the reason for this is that they were lacking an objective standard of measurement. Even if they are writing and passing level tests, they are doing so with other students who have also passed these tests, and so they are always in an environment where students are feeling they may not be progressing, and find it difficult to see what they have learned so far.

My web building course, however, offers an experiential approach to language learning. The goal is clear and yet open-ended, and does not involve a focus on acquiring a specific and perhaps artificial set of skills students will be tested on. The students are not as conscious of their attempts to learn the language because they are so focused on the task of web building. It also creates a need...
for students to use and improve the skills they already have in several different
areas. Students’ confidence in their language and computer skills increase as
they see their websites develop on a daily basis, culminating in published
websites that can be seen around the world. This increase in confidence and
sense of accomplishment by my students also makes me feel better about my
role in their learning.

Reading

Reading and comprehension is a major aspect of the web building course. The
beginning portion of the course is devoted to identifying good website design. It
is easy to make a bad website quickly, but more difficult to make a usable
website, and students must learn what makes a well-designed website before
they can do it themselves. For many tasks in this area of usability, students
must conduct research on the Internet to navigate through search engines to find
examples of websites that they think are well-designed. This includes sites that
are readable and easy to navigate. We discuss the need to make links and
headings to pages descriptive and meaningful. As this type of activity makes use
of authentic materials, as recommended by Swaffer, Arens, and Byrnes (1991),
students are given an opportunity to develop higher-order cognitive skills.

In the part of the course that deals with images, students must learn how to find
the file sizes and formats of images. For this they must use keywords to search
for images that fit the theme of their own websites. This means they must learn
to scan summaries and descriptions of websites to find those with a related
theme to their own. For example, if a student wants to create a website about
dolphins, they must find websites on the same topic.

Students must also find the file sizes and formats of these images. This requires
right-clicking their mouse, finding the properties of an image, and scanning the
properties information for the file size. Because of the fairly high number of
images that students must check the properties of when they do find a suitable
image, they must become proficient at reading for a specific purpose.

Another task that requires scanning for specific information is finding three
examples of good site maps and showing them to classmates. For this they
must scan the navigation links of websites, find a site map if a website has one,
assess how useful a site map is and why.

Aside from the researching of other websites, students must also employ reading
skills in the use of the course reference manual. Sometimes parts of the manual
are assigned for homework. Students also refer to the manual when they forget
how to do a particular task that was covered already. They can then follow the
step-by-step directions. For example, at the end of every class students are
required to back up their website onto a floppy disk. I had one student who could not remember the steps. After I told this student how to do it several times and they still could not remember how to do it in the next class, I directed them to the manual and they could successfully read through the directions and get the task done.

I also had a case where a student had missed two critical days in the first week of the course where we started using Dreamweaver, the main software application for the course. He was able to follow the manual by himself to get caught up to the rest of the class.

By constantly asking for feedback from my students (suggestions, sections and words they don’t understand etc.). I am still improving the readability of the manual. I found that earlier versions of the manual were written in English that was too difficult for them to understand and had to rewrite a large portion of it.

Some sections of the manual are assigned as a review for homework. At times there are also things that some students want to do that time does not allow us to cover in the course as a group, such as how to email a website.

Each section of the manual also has a review and exercises to check the students comprehension of the text, as recommended by Grellet (1981). Sometimes I have students read out the review questions and have the other students answer them. At times I also have students take turns reading out other parts that are related to the material we are covering in class and then ask students questions to check their comprehension. I also take this opportunity to help with pronunciation.

Another aspect of the course that requires reading for a purpose occurs when students have to visit my website for web building resources and further web building documentation. This is an ongoing process since each of the pages on my website has a feature that allows them to register to receive automatic notifications when a page on my site changes. They can then go to the webpage and see what new content has been added. I am notified of how many students are monitoring what pages for updates.

Other reading that students must do is for the emails in the course. I send them links to relevant websites, reminders of upcoming deadlines, the graduation requirements, notifications of additions to my website when it applies to the course, instructions on how to do things they request, and answers to their questions when they need help outside of class. I also give them feedback on their websites as they develop.
Listening

Listening and comprehension is a major part of the class. Students must listen to directions in authentic English (as suggested by Long 1986) in order to be able to learn how to do the various steps required to complete a task. For example, if a student wants to add a rollover image, they have to listen to me as I tell them to go to the Insert menu in Dreamweaver, click on it, go to Interactive Images, and choose Rollover Image. If the student does not understand me then they can ask me to repeat the instructions. I discourage looking at the screen of the student next to them so that they must focus on listening. I can immediately check their comprehension by seeing if they are able to follow the instructions.

Consistent with Schema theory of language acquisition, through repeating tasks that involve a common vocabulary (e.g., left, bottom right, open, close, minimize, go to, find, save, servers, host, remote, local, upload, display, optimize, site map etc.), students have an opportunity to become familiar with a certain set of vocabulary. Because many of the procedures for completing a task in Dreamweaver are similar, they are also being given a chance to increase their comprehension through the repeated exposure to similar sets of instructions.

Speaking

The speaking component of the class covers several aspects. If a student would like clarification on a task they must ask me or another student in English. To help the students build up a repertoire of “help English”, we make a list of phrases on a large piece of paper that we have on the wall. We do this for each course and add to it as students learn new sentences. Originally I included a list from one class in the course manual, but have since removed it since it isn’t necessarily the same English students from the next class will need, and also I want each class to create their own list. Here is a sample of the types of sentences a class has generated:

Could you repeat that please?
I don’t understand what you mean.
What does _____ mean?
What is the proper way to say this?
Can you come here please?
Can you help me please?
Can you email the URL to that website please?
How do you spell…?
Do you mind if I borrow…?
How can I…?
How can I download Dreamweaver?
What did we do in the last class?
What are we doing next/now?
I’ve done that already.
I’ve done it!

Students are also encouraged to keep their own notes of English help phrases they learn in class, as well as add any vocabulary words and other notes to the manual.

There is a presentation aspect to the course at several stages. Near the beginning of the course we look at various aspects of websites that make them either good or bad in design. The students then must find and present three good and three bad websites to the other students, showing exactly what it is about the websites that made the student choose them. I found that this quickly loosened up the class as interests and hobbies where revealed in the selection of websites. This also generated impromptu questions and answers from other students about the presenter and the selections.

Another major presentation occurs at the end of the course when the websites are completed. At that time we have a kind of open house where we invite teachers, students and the owners of the school to come and see the final results. Graduation certificates for the course are presented, pictures are taken, and each student takes turns presenting their website, showing and describing the features and what it is about, and fielding questions. Each time we have done this the students were clearly proud to present their work. The sense of accomplishment is clear after only one month of hard work. At the beginning of the course the students had no idea how to create a website. (I discuss at the beginning of the month how making a website must seem like magic to them at that point and they agree). At one such event the owner of the ESL school said that he had paid up to $5,000 dollars for websites that were similar. This made the students feel very good.

I have proposed that at the end of this current course we should have a general open house in the school where students in the various programs (e.g., TESL Certificate) can visit each other and share their accomplishments. The school has agreed this would be a good way to motivate students and for them to share what they have learned with others.

Writing

The minimum requirements for the course include 5 web pages on student’s sites. These pages must have a certain number of images and content.

On the first day of the course I show the students examples of previous student pages. This usually impresses them and helps to set a benchmark for them to
aim at. As the Korean students in my class seem to be very adept at Internet technologies and eager to demonstrate their skills, showing them what previous students have done seems to have the desired effect of motivating them to do the best job possible. This contextualizing of the purpose of the class also provides them with ideas as to what they themselves might do or incorporate into their own projects.

To help the content-creation process, students are taken through a planning stage where they decide on a theme and purpose for their site. Next, they are shown how to storyboard their website so that they have their website design and content for each page planned before they start building the actual site. Storyboarding involves drawing how each webpage will look, complete with links, placement of images, headings and nature of the content of each page. I check all storyboards before we begin the next stage of making the actual website as it is necessary to know how many pages the website will initially have, what they will be called, and the names of the links that will be connecting them. After that stage they continue to develop their content in a process writing approach on their computer, as recommended by Jacobs, Zingraf, Wormuth, Hartfiel, and Hughey (1981).

The content is up to the students, but it must include something like a movie review, autobiography, recipes, an essay on their experience in Vancouver, or something else they generate that is suitable for the purpose and audience they have decided to build their website for. Other peers then review their content and provide feedback and suggestions for improvement. Students are also shown how to use the spell check feature in Dreamweaver as an aid to proofing.

Students add descriptive text as an Alt tag to every image so that blind people can have their computerized web readers read out the descriptions of the images (in accordance with the American Disabilities Act). How to present information in the most readable form in a web-based environment, keeping in mind that people are usually looking for specific information is also covered. This includes keeping paragraphs short, not having text stretch across the screen, using lists where possible, using the proper size font, and choosing text and background colors that offer good contrast. This forces them to consider the audience for their work.

Setting a minimum requirement in terms of pages and content has proven to be a good idea, as I initially had a student who was not very generative. I set a minimum number of pages and suggested some topics for content and by the end of the course they had produced a solid travel section that had taken a long time for them to write. I also set other minimum requirements for graduation including a certain number of images and rollover images, links to other websites, and a demonstration of the ability to create lists, among other things.
have found that in specifying these requirements the students are given a framework from which to create a larger body of work.

The power of being able to publish content and have it immediately accessible by the rest of the world has proven to have a strong motivational factor for the students. We discuss in class who we would like to notify about our websites, and many want to share their websites with friends and family. Other students choose to create a portfolio of their work (graphic design, calligraphy, etc.) for a future job. We discuss the fact that these websites will continue to be works in progress that students can add to any time they want. Some students have chosen to add counters to their sites so they can check in on their sites periodically to see how many visitors they have had.

Students also engage in writing in the form of informal emails to me and their peers, as well as real-time chat. I use this opportunity to help them with their writing skills as well as provide technical support.

In order for students to first download Dreamweaver, and also get hosting space on Tripod, they must follow instructions that include filling out forms giving information about themselves, as well as general steps for registering and downloading the software.

Another task that requires researching websites for specific information comes toward the end of the course as we make the final preparations to the websites in order to submit them to search engines. Students must find summarize their websites in a short description of about 250 characters for visitors who find their sites in a search engine. Again, this requires deciding what their target audience is and writing for that purpose. They must also compile a list of about 20 keywords that also highlight the content, theme and purpose of the site. These keywords must be ones that the students think other people would use. For example, one student made a website to support an ESL agency she wants to open in her own country. This was her description: "For people who want to study English in Vancouver, Canada. We help you choose the best English language school for you. You will find Vancouver info., school info., online counseling, how to apply." Part of this process in deciding an appropriate description and choice of keywords is researching similar websites and seeing what they use. This information is embedded in the HTML code and students must read through this code for the information they want.

Visual

Another aspect of the course is visual learning and expression. In the storyboarding phase of developing their websites where students must draw on paper each page all links, images, content, colors and layout, those students who
are good visual learners and used to a paper-based way of expressing themselves to build a solid understanding of their project before they start creating it on their computer. I have found that the storyboarding portion of the course to not only be a critical and necessary part of good website development, but an opportunity for those who are not as familiar with the Internet and websites to picture how this medium is organized. Other students who have a stronger background in computers such as networking or programming are also given a chance to plan out the presentation of their website in a medium that encourages careful consideration of the design and organization in a medium they don’t usually use in a way that facilitates a more visual style of content creation.

After the storyboards are planned, in the web building environment on their computers, students are shown how to be able to add background images to the background of pages or part of pages, add images and control their size and layout, choose the style, size, color and alignment of text, and offer a readable presentation of text. They must also decide how to best provide navigational links within their site. They must do so again within a framework that is understandable to visitors who may be adaptive learners, elderly, or be using different types of computers.

Vocabulary

Initially my idea was to have the students generate their own vocabulary list for each class. After trying this, however, it became clear to me that because a lot of the concepts they were learning were new, they didn’t know what they should be learning. This is in contrast to other ESL classes I have done this in where the students might know a vocabulary word but not be quite sure of the meaning, or can offer a new word that other students might not know. I ended up creating a glossary of terms we learn in the course and adding it to the end of the manual. The first few instances of a vocabulary word in each section of the manual are underlined to indicate it has been defined in the glossary.

Future ideas for this course

As mentioned above, I want to have students offer a section on their website where visitors can hear a recorded voice message. It could be a welcome message, and introduction, or reading out an essay that they have made.

I plan to make a crossword puzzle based on the vocabulary terms that the students can fill in to give out as homework. This will allow the students (as well as myself) to have an opportunity to make sure they are familiar with all the words in the vocabulary section of the manual. It also recognizes the views of researchers such as Met (1991) who suggest that specific learning objectives
should be included in a content-based environment. I'll include it with future versions of the manual.

I may be more specific about the amount of writing that they include in their content. Until now I suggested but didn’t require a writing sample of a specific length as a graduation requirement. This is because for some students the purpose of their website was to create a work-related portfolio. I am also considering having students write me an essay at the beginning of the course on what they expect to accomplish in the course, and then again at the end of the course reflecting on their experience. We are now considering extending the hours of the web design course and this will allow more time for assignments such as this.

A different area that I would like to explore is having students record messages and allow them to be played on their websites. We have looked at how to add sounds to our sites in previous courses, but again, due to the very short time of the course few students have had the time to do this.

I may add some animated tutorials to my website that visually demonstrate how to do certain things in Dreamweaver as an alternative to my manual. These tutorials can be paused and repeated as necessary and will accommodate learners who have different learning styles, (more visual and auditory style of learning) as recommended by Oxford (1990). The tutorials would include English instructions inside pop-up windows, and a voice-over describing the steps. Examples of this technology can be viewed on my website at http://www.purplesunsetdesigns.com/viewletshortcut.htm.

I am in the process of setting up a message board on my website. I plan to use this as a forum for students to ask and receive feedback from each other about their website, as well as offer and receive help with technical issues. Hopefully this type of asynchronous communication will lead to the development of an online community among the various classes.

Conclusion

By offering this content-based class the students have had a chance to develop real language skills in many areas, satisfying Sterns authentic language needs lead to more effective language acquisition (1990). As a teacher, I have found that leading this course has been rewarding because I get immediate feedback on students understanding and progress. Furthermore, as has been suggested by proponents of content-based instruction for language acquisition (Snow, Met and Genesee 1989), students are learning and using English in an authentic environment for a real purpose. The community of the classroom extends beyond classroom hours and the length of the course itself. Students continue to
communicate with me and other students through email, chat and their websites. Students are motivated and enthusiastic about their projects, leading to more success in language acquisition (Gardner 1985). They are given an opportunity to express themselves creatively and artistically using the target language. Graduates leave with a published portfolio that can be accessed world-wide that they can and do continue to build.
Bibliography


How to Make a Website

By Scott Dagilis

www.purplesunsetdesigns.com
Creating your first page ................................................................. 41
Adding pages to your website ....................................................... 43
.htm or .html? ................................................................................ 43
Naming Images and Folders ......................................................... 44
Review ........................................................................................... 44
Exercise ......................................................................................... 44

CHAPTER 4: TEXT ........................................................................... 45
The Property Inspector .............................................................. 45
Text format and font style ............................................................ 45
Font size ....................................................................................... 46
Text Color .................................................................................... 47
Bold and Italic ............................................................................. 48
Justify (Align) .............................................................................. 48
Linking to other pages .............................................................. 48
Open page in a new window ...................................................... 49
Lists ............................................................................................... 49
Nested lists .................................................................................. 50
Indents .......................................................................................... 50
Inserting spaces .......................................................................... 50
Inserting paragraphs ................................................................. 50
Moving to the next line without leaving a space ..................... 50
Horizontal Line Breaks ............................................................... 50
Changing Background Color ..................................................... 51
Inserting Flash Text ................................................................... 51
Review ........................................................................................ 52
Exercise ....................................................................................... 52

CHAPTER 5: SAVING, PREVIEWING AND BACKING UP .................. 53
Saving your work ......................................................................... 53
Previewing your work in a browser ........................................... 53
Viewing the HTML code ........................................................... 53
Adding a title to a webpage ....................................................... 54

CHAPTER 6: FINDING IMAGES AND IMAGE FORMATS .................. 55
Where to find images ................................................................. 55
JPEG Vs GIF image formats ...................................................... 56
Ideal image file sizes .................................................................. 58
Exercise ....................................................................................... 58
Review ........................................................................................ 59
Further resources: ..................................................................... 59

CHAPTER 7: WORKING WITH IMAGES ........................................... 60
Copying an image from a website ................................................. 60
Inserting images .......................................................................... 60

© 2002 Scott Dagilis www.purplesunsetdesigns.com
Changing image properties ........................................................................................................61
Creating rollover images ........................................................................................................62

CHAPTER 8: WORKING WITH IMAGES: ADVANCED ..........................................................63

Thumbnails for visitor choice ................................................................................................63
Resizing and optimizing images ...............................................................................................64
Adobe Photoshop ....................................................................................................................64
Online image optimizers .........................................................................................................65

CHAPTER 8: TABLES .............................................................................................................66

Inserting tables .......................................................................................................................66
Exercise ..................................................................................................................................67

CHAPTER 9: LIBRARY ITEMS AND TEMPLATES ................................................................68

Creating Library items ...........................................................................................................68
Inserting Library items ..........................................................................................................70
Editing Library Items ............................................................................................................70
Creating a website template .................................................................................................70

CHAPTER 10: JAVASCRIPT AND OTHER EXTRAS ............................................................72

Including JavaScript code .......................................................................................................72
Adding free, outside services to your site ................................................................................73
How to use these services .......................................................................................................73

CHAPTER 11: TESTING YOUR SITE ....................................................................................75

Testing Checklist ....................................................................................................................75

CHAPTER 12: REGISTERING YOUR SITE WITH SEARCH ENGINES ................................77

Search engines and directories ...............................................................................................77
What search engines look for .................................................................................................77
Meta tags ................................................................................................................................78
Find and Replace feature .........................................................................................................78

CHAPTER 13: WEBSITE PROMOTION AND MAINTENANCE .........................................79

Promoting your site ................................................................................................................79
Maintaining your Website .......................................................................................................79

APPENDIX ..........................................................................................................................80

Web building vocabulary ..........................................................................................................80
Keyboard shortcuts ..................................................................................................................83
FAQ: Frequently Asked Questions to common problems .......................................................83
How to email webpages ...........................................................................................................85
Analyzing other Webpages .....................................................................................................86
Using Dreamweaver Help ........................................................................................................86
Recommended Books .............................................................................................................87
Other popular web building software .....................................................................................87

© 2002 Scott Dagilis www.purplesunsetdesigns.com
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dreamweaver vs. FrontPage</td>
<td>87</td>
</tr>
<tr>
<td>Other Web building editors</td>
<td>88</td>
</tr>
<tr>
<td>Image editing software</td>
<td>89</td>
</tr>
<tr>
<td>A NOTE TO TEACHERS</td>
<td>90</td>
</tr>
</tbody>
</table>
Introduction

Using this manual

- Underlined words identify vocabulary words; definitions are in the vocabulary section.
- Blue underlined text identifies links.
- For more information on web building visit www.purplesunsetdesigns.com. You can also go to www.otlhelp.com and it will automatically switch to the above website.
- For an updated list of links to web building websites, go to www.purplesunsetdesigns.com/webcourse.htm
- Questions? Refer to the FAQ section or email me at scottdagilis@hotmail.com

What you need to know for this course

Before you begin this course, you must be able to:

- Send and receive email. We will be using Hotmail or Hanmail in this course.
- Find a specific website, for example www.cnn.com.
- Cut and paste text from one window (such as a website) into another (such as a word processor).
- Create and open a folder on your Desktop.

What you will learn in this course

In this course you will learn all the basics of creating a website, including how to:

- Plan content, navigation and design of a website.
- Create a webpage using HTML.
- Use Macromedia Dreamweaver to create and edit websites.
- Use Adobe Photoshop and free online services to prepare images for the web.
- Identify what makes a good or bad website.
- Make your website easy to read and navigate.
- Change the size, font style, alignment and color of text.
- Create numbered and bulleted lists.
• Check spelling automatically.
• Create links to other websites.
• Add email links.
• Add background images.
• Find images and websites using a search engine.
• Add, resize, optimize and crop images.
• Create thumbnail images.
• Properly format images for best results.
• Control the layout of images and text.
• Add multimedia such as Flash movies, animations, rollovers and sounds.
• Create Flash buttons and text.
• Include JavaScript in your website for special effects such as mouse pointer trails, moving text, and games.
• Add extra features like message boards, guest books, personalized welcome messages, real-time news, counters, automatic page change notification, etc.
• Add new pages and update a website.
• Develop a website quickly using Library items and templates.
• Reduce the file size and download time of your webpages.
• Host your website free.
• Back up and/or move your website.
• Properly test your website on different resolutions and browsers, and for broken links.
• Add meta tag keywords and descriptions as well as page titles for optimal search engine placement.
• Register your website free with search engines.

This manual also includes sections on the following

• Computer and web building terms. Any word that is in the vocabulary list is underlined.
• FAQ's (Frequently Asked Questions).
• How to email webpages.
• Create cascading style sheets (CSS) with Notepad.
• An overview of other web-building software and what it does.
• Using Dreamweaver Extensions:
• Using Dreamweaver Help.
• Locating useful web building resources such as books and websites.
Chapter One: HTML

HTML stands for Hypertext Markup Language and is the language used to create webpages on the Internet. HTML tells a web browser (such as Internet Explorer) what pictures and text to show, and how to show it. It is quite a simple computer language that closely resembles English.

Creating an HTML document

To create a basic HTML document, you can use a text editor such as Notepad on a PC (e.g., Windows) or SimpleText on a Mac (e.g., Macintosh Computer). To begin creating an HTML page on a PC, first open Notepad. To do so:

1. Click on Start.
2. Go to All Programs.
3. Navigate to Accessories.
4. Click on Notepad.

Now that Notepad is open, you can type in the basic structure that all HTML pages must have:

```
<html>
<head>
<title></title>
</head>
<body>
</body>
</html>
```

All text you would like to show on your webpage goes between the <body> and </body> tags. Go ahead and either type or cut and paste some text there now. Add a title for your page, such as My First HTML Document, between the <title></title> tags.
Viewing your document as a webpage

Save your document as an HTML file. To do so:

1. At the top left of Notepad, click on File.
2. Click on Save As...
3. In the window that opens, next to File name: type in htmlpractice.html.
4. Save it to your Desktop.

Next, let’s view your document in a browser. To do so:

1. Go to your Desktop. Click on the document called htmlpractice.html. It will open in a browser. You see only the text you placed between the <body> and </body> tags. Notice your text is not formatted. Remember to refresh your browser if you don’t see recent changes you have made.
2. Right click on the browser and choose View Source. You will see the HTML along with the text.
Formatting text

Here is a table of basic HTML tags you can use to control the formatting and layout of your text:

<table>
<thead>
<tr>
<th>HTML tag</th>
<th>Effect</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;b&gt;bold text&lt;/b&gt;</td>
<td>bold text</td>
<td>bold text</td>
</tr>
<tr>
<td>&lt;i&gt;italics&lt;/i&gt;</td>
<td>italics</td>
<td>italics</td>
</tr>
<tr>
<td>&lt;u&gt;underlined text&lt;/u&gt;</td>
<td>underlined text</td>
<td>underlined text</td>
</tr>
<tr>
<td>&lt;br&gt;line break&lt;/br&gt;</td>
<td>line break, but no space between lines</td>
<td></td>
</tr>
<tr>
<td>&lt;p&gt;paragraph break&lt;/p&gt;</td>
<td>paragraph break, with space between paragraphs</td>
<td></td>
</tr>
<tr>
<td>&lt;font color=&quot;red&quot;&gt;red text&lt;/font&gt;</td>
<td>red text</td>
<td>red text</td>
</tr>
<tr>
<td>&lt;font color=&quot;green&quot;&gt;green text&lt;/font&gt;</td>
<td>green text</td>
<td>green text</td>
</tr>
<tr>
<td>&lt;font color=&quot;blue&quot;&gt;blue text&lt;/font&gt;</td>
<td>blue text</td>
<td>blue text</td>
</tr>
<tr>
<td>&lt;font color=&quot;purple&quot;&gt;purple text&lt;/font&gt;</td>
<td>purple text</td>
<td>purple text</td>
</tr>
<tr>
<td>&lt;h1&gt;introduction&lt;/h1&gt;</td>
<td>creates a large heading</td>
<td>introduction</td>
</tr>
<tr>
<td>&lt;h2&gt;introduction&lt;/h2&gt;</td>
<td>creates a smaller heading</td>
<td>introduction</td>
</tr>
<tr>
<td>&lt;h3&gt;introduction&lt;/h3&gt;</td>
<td>smaller yet</td>
<td>introduction</td>
</tr>
<tr>
<td>&lt;h4&gt;introduction&lt;/h4&gt;</td>
<td>even smaller</td>
<td>introduction</td>
</tr>
<tr>
<td>&lt;a href=&quot;http://www.google.com/&quot;&gt;Google&lt;/a&gt;</td>
<td>create a link to the Google website</td>
<td>Google</td>
</tr>
</tbody>
</table>

**Tip:** All tags must be inside pointed brackets <>. To turn off the effect of a tag, simply repeat it but include a forward slash / in front. An HTML tag, such as <b>, starts something and therefore is called an opening tag. A tag such as </b>, stops the effect and therefore is called the closing tag.
HTML Review

What does HTML stand for?
What are the two basic software tools we need to make a webpage?
If you make changes to your webpage in Notepad, what do you have to do to your browser to see the change?

Exercise

Practice modifying your current HTML document by including some of the HTML tags in the list above. For example:

```html
<html>
<head>
<title>My First HTML Document</title>
</head>
<body>
<h2>Welcome Friends!!</h2>
Welcome to my <b>first</b> webpage!
<br>
HTML seems quite <font color="red">easy</font> and <font color="purple">fun</font>!
</body>
</html>
```

View it in a browser and see how it looks. Remember to save your document with the extension .htm or .html.
Chapter Two: Website Design

Steps in designing a website

The following steps show the approximate percentage of time each one takes:

1. Planning the purpose and content (15%).
2. Storyboarding (outlining the flow of the site) (25%).
3. Creating the site in an HTML editor (50%).
4. Testing the site and registering it with search engines (10%).

Planning the purpose and content

The first step to creating a website is to plan what you want to have in it. Do some brainstorming. What is the theme of your website? If you can’t think of a topic, make it about you.

Take some time now to make a list of things you can include in your website. Things you might want to include:

- An introduction about yourself, your background and hobbies.
- Any pictures you have about yourself, friends, pets or family.
- Information and pictures about your hometown or the city you are in now.
- Pictures or animations you have seen on the Internet, such as animals, cartoons, nature, or cities.
- Your email address, so people can contact you.
- Links to websites you like.
- Links to your friends' websites.
- Links to your school website.
- Stories, essays, or poems you have written.
- Anything else you want!
Storyboarding your site

Now that you have an idea of the purpose of your website and what a good website looks like, the next step is to plan how the pages will look and how they will connect to each other. This is called Storyboarding. This step is very important, as it could save you much time and trouble later if you do it properly. Using a separate page of blank paper for each page of your website, plan out what you want to have on each page. For your first website, it is best to keep it limited to three to five pages.

Proper planning at the storyboarding stage will prevent hours of extra work later on. However, storyboarding is a skill that is learned, and as you practice making websites you will get better at this. In fact, if this is your first website, be prepared to make many mistakes and even to have to redo your website again to get it just the way you want. This is quite common. Think of this first time as a learning experience and a chance to experiment. Don’t worry about mistakes so that you can have more fun at this learning stage.

What is good website design?

Ensuring that viewers get around a website site easily is referred to as usability, an important concern when web building. The goal of usability is to allow visitors to find what they want as quickly and easily as possible. Many studies have been done to learn how people find things on websites, what they see and don’t see, and what they like best. Jakob Neilson is one expert on usability. His website is at: www.useit.com. Here is a partial list of design elements that work and don’t work:

**Clear, consistent font styles**
Make sure that you choose a font that is readable, then use it consistently throughout your site. Some popular fonts are Arial, Courier, and Times New Roman. Some people feel that Arial is easier to read because the edges of the letters are rounded. Use no more than 2 to 3 fonts in your site.
Proper font size
A common mistake for beginning web builders is to use a font size that is too big. There is a general rule when it comes to the size of headings and regular text (body text). This is the "40-20 rule". This rule explains the percentage that your headings should be compared to your body text. Your main heading should be 40% larger than your body text. Any headings under your main headings should be 20% larger than the body text. This chart gives examples:

<table>
<thead>
<tr>
<th>Text Type</th>
<th>Font Size (print)</th>
<th>Font Size (web)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading 1</td>
<td>14</td>
<td>+1</td>
</tr>
<tr>
<td>Heading 2</td>
<td>12</td>
<td>none</td>
</tr>
<tr>
<td>Body text</td>
<td>10</td>
<td>-1</td>
</tr>
</tbody>
</table>

The same 40-20 rule should be used for documents you create with a word processor. For example, if your body text is Arial 10 pt., the heading of a section (called heading 3 or H3) should be 11 pt. The next size of heading should be 12 pt. and the largest heading on your site (perhaps the title of each page) should be no greater than 14 pt.

Because you are building pages for the web, you don’t have control over the absolute value of the size of the fonts on your website—only the relative values. This means that you can’t control the exact size of words in a paragraph on your website—only what size they will be in relation to the headings. This is because a visitor could simply use their browser settings to choose a different size of text.

Readable text
Studies show that people don’t look at websites the same way they read books. Instead, they scan very quickly for the exact information they want. Breaking up your text into small chunks of one to four sentences can help them read more easily. Leaving a blank line between paragraphs will also make a page more readable. Using bullet points and lists whenever possible helps too.

Light page backgrounds
If you choose a color or image for the background for your page, make sure it is not too dark; this makes the text too difficult to read. Also, visitors to your site may have poor eyesight or bad computer monitors; remember that, even if you can read the text on your computer, others may not be able to on theirs. Studies have shown that websites with a plain white background are the easiest to read.
**Consistent link colors**

There is another rule regarding the color of links: it's easier for visitors if link colors are the same on every website. This is so that when people visit your site they know what to expect. Here is a chart that lists what colors should be used:

<table>
<thead>
<tr>
<th>Type of link</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>A link you haven’t clicked on yet</td>
<td>Blue, underlined</td>
</tr>
<tr>
<td>A link you have visited</td>
<td>Purple or red, underlined</td>
</tr>
<tr>
<td>Regular text</td>
<td>Black</td>
</tr>
</tbody>
</table>

As you can see, this rule is very simple. And yet, many websites confuse their visitors because they don’t follow this rule. You may have been to a site where the links are not underlined, and you can only tell what is linked by moving your mouse around and seeing if the pointer changes. Some people call this scrubbing the screen with the mouse. Also, you have probably been to a website where the text was a different color or underlined, and when you tried to click on it you realized it wasn’t a link at all. A well designed website doesn’t confuse its visitors. If you really want to change the color of your links, at least make sure that all your links are underlined.

**Page lengths**

If your webpages are too long, a visitor may not want to scroll down to the bottom. If possible, keep your front page to one monitor screen length so that a visitor doesn’t have to scroll when viewing the introduction to your site. Keep the other pages to a maximum of three screen lengths. If they are longer, it would be better to break them into multiple shorter pages.

**Good navigation**

There is an idea in navigation called the “Three Click Rule”. This rule says that a visitor to a website should be able to get to the information they want within three clicks. Think about some of your favorite sites—do they follow this rule? Have you ever been to a website where not only does it take more than three clicks to find what you want, but you can’t find the information at all even though you know it's there somewhere? Did you find this frustrating? Good; remember this feeling when you carefully plan the navigation of your site so that your visitors won’t go through the same unpleasant experience.
How can you design your site to follow the three-click rule? Here are some tips:

1) **Make sure that your website is shallow and wide instead of narrow and deep.** That means that a visitor has a large selection of links to choose from on your front page, and can reach other pages on your site quickly.

2) **Plan your categories carefully.** For example, if you have a three sections, one containing favorite links, one for poems, and one for your resume, have different links to each of these sections.

3) **Use descriptive linking words to identify each section.** Don’t use meaningless words like “Stuff” or “things to look at” or “more”. If someone doesn’t know what is in a section, they probably won’t click on it.

4) **Breadcrumbs.** These tell a visitor where they are and where they came from.

   Breadcrumbs look like this:

   You are here: Home > About Me > My Cat

This tells a visitor that they are looking at a picture of your cat that is in the **About Me** section of your website.

---

**Site map**

Many people also like to go to a site map to get an overview of the site: what pages the site has and how they are connected.

**Search feature to find things on your site**

Studies show that, if a search box is present, forty percent of users go straight to the search box to find what they want on a site.

**Fast Download times**

It is important that visitors don’t have to wait a long time to see a website. If a website has too many pictures, or they have been designed wrong, this will make you wait before the pages appear on the screen. We will talk more about this later.
Further reading:
To learn more about how long visitors to your site will wait, read “Response Times: The Three Important Limits” by Jakob Nielsen at www.useit.com/papers/responsetime.html
For more information on designing for the web, try the Yale Style Guide at http://info.med.yale.edu/caim/manual/contents.html.

Planning and design review

• What is Storyboarding and why is it important?
• What is the 40-20 rule of heading sizes?
• What colors are standard for links?
• Should text be underlined?
• What is a good background color? What is a good text color?
• What is the maximum number of screen lengths for a single webpage?
• Why do people read webpages differently than text? How can you make text more readable?
• What is usability?
What are breadcrumbs and what are they for?

Exercise

1. Find three websites you like and three you don’t like. Write down the addresses of the websites so you can share them with other students. Explain what parts of each of the websites you like or don’t like.
2. Go to www.purplesunsetdesigns.com and look at the examples of bad websites. (Do a search for “bad websites” if you can’t find them easily on that site.)
3. Find three examples of site maps. Bookmark the sites or write down the addresses. Do you find them easy to use? Why or why not?
Chapter 4: Hosting your website

After you make a website, you have to send it to another computer that will host it for you. This means that the other computer will act as a server, serving out your website to visitors. We will be using a free web host service called Tripod. Another free service is Geocities, but Tripod allows us to have a short website address (yourname.tripod.com); compare that with the longer addresses you see at Geocities. Tripod is free because they make their money by putting an advertising banner on each of your webpages.

To get hosting space at Tripod, you have to go to www.tripod.com and sign up. Make sure you write down the exact name and password you use to do this; You will need it later. When Tripod asks for other information such as your home address and email address, put in false information. If you don’t, you will be getting a lot of junk mail. In the birth date section, be sure to pick a date that shows you are over 20 years old.

If you want to buy a domain name for yourself, such as www.mariko.com, you have to check to see if the domain name is available, buy it for approximately $25.00 Canadian a year), and find a company to host it. I use Dollarhost at www.dollarhost.com. They charge $5.00 a month and have good service. The cheapest price I have seen for a domain name is about $10.00 U.S. at www.godaddy.com, but you might be required to have them host your website.
Chapter 5: Using Dreamweaver

What does Dreamweaver do? Basically it takes care of the hard work for you, writing the HTML code that every web browser (for example Internet Explorer or Netscape) understands. Web surfers (people using the Internet) normally don’t see the hidden HTML code that is behind every webpage.

Downloading Dreamweaver

The full version of Dreamweaver costs several hundred dollars, and the educational version about half-price. You can buy it at www.macromedia.com. However, you don’t need to purchase Dreamweaver to learn how to use it. Macromedia offers a full trial version for up to 30 days. To get the free trial version:

2. Navigate to the Products section.
3. Click on Dreamweaver MX.
4. Look for a Download link.
5. Choose the Trial version. You will be asked some information about yourself at this point. My preference is to simply enter any information in the required fields in order to fill out the forms more quickly, instead of taking time to be accurate.

Once you have finished this step and begun the download, you will be asked where you want to save Dreamweaver on your computer. Saving it to the Desktop allows you to find it more easily once it has downloaded fully.

Since the program is rather large, if you are on a phone modem connection it may take from one to five hours or more to download. Starting the download before you go to bed at night can both allow you to achieve faster download times and dedicate your computer to downloading while you are sleeping.
Preparing to create your first website in Dreamweaver

**Creating a root folder**
While you are waiting for Dreamweaver to download, create an empty folder on your Desktop. This will be the root folder where you will store the webpages and images you use for your website. To do this:

1. Go to your Desktop by clicking on the Desktop icon on your toolbar. This will minimize any open windows.
2. Right-click on your Desktop and choose New Folder.
3. Click once on the label of the new folder and change the name to something meaningful such as “Mariko’s website June 2003”. Adding a date to the name is a way of easily identifying this website from others you may be creating in the future.

**Installing Dreamweaver**

Double-click on the Dreamweaver installation package. It will open up.

1. Click Accept or Next for each question.
2. When it asks you if you want to try the trial version or if you have a serial number. Select Try.
3. When it gives you a choice of views, choose the one on the right.
4. The page that opens up is the Site Map.

**Tip:** Drag the green Dreamweaver icon from the window to your Desktop if you don’t want to go to the Start menu to open Dreamweaver every time. I like to drag the icon to the toolbar at the bottom of the screen (next to the Start menu) and leave an icon there for quick access. (Not all Windows versions allow you to do this).

Dragging an application icon to the bottom toolbar allows quick access to it.
The Untitled Document page

If Dreamweaver has already been installed on your computer, you may see a page that says **Untitled Document** at the top left. It looks like this:
The Site Map

To open the Site Map window:

From the **Untitled Document** window, go to the **Site** Menu and choose **Site Map**.

The Site Map is the control center for creating a Website in Dreamweaver. From this window, you can see every page you create in a Website and how they are connected together.

![The Site Map]

Defining a new site in the Site Map

Choose **New**. The following screen will appear:

![Site Definition for My First Website]

A site, in Macromedia Dreamweaver MX, is a collection of files and folders that corresponds to a website on a server.

What would you like to name your site?

**My First Website**

Example: MySite

Site Definition box.
Go to the Advanced section by clicking the **Advanced** tab. You will then see this:

![Advanced section of the site definition window](image)

Next to **Site Name**, type in the name you want to give to your website. This tells Dreamweaver what you will be calling this website. It would be best to use a meaningful name. Let’s use **My First Website**.

Click the yellow folder next to the **Local Root Folder** dialog box.

Browse to your Desktop and choose the root folder you created called **My First Website**. This tells Dreamweaver where it should be keeping the pages you will be creating for this site.

Next, click on **Remote Info**. This is where you enter information that allows Dreamweaver to connect with the computer that will be hosting your website on the Internet. Look at the next picture to see how this is done.

**Tip**: Be SURE to type in your password correctly--no uppercase or spelling mistakes. If you forget your tripod username or password, go back and create another account.
Creating your first pages

Creating your first page
There are two special things you must do to your first page. The first is to name it index.html. The second is to set it as the home page. To do so:

1. The Site Map is split into two halves. The left half represents what you will have published to the Internet (the Remote Site), and the right half shows you what you have created on your computer (the Local Site). Right-click on the green folder in the Local Files window.

2. Choose New File.
3. Name the page **index.htm**. Every first (home) page of every website must have this name.

4. Next, right-click on the green page icon and choose **Set as Home Page**. This tells Dreamweaver what the first page is so it can make a site map in the left side.
Adding pages to your website

There is a quick way to add additional pages to your website:

1. Right-click on the yellow folder and choose **New File**.
2. Next to the new page you see, type in a meaningful name for the page. For example, for your page of favorite links, call it **favlinks.htm**.
3. Continue until you have created all the pages in your site.
4. To have your new pages listed in alphabetical order, go to **View** and choose **Refresh**.

![File tree example]

It is extremely important that you keep your website pages and images organized. Create a new folder to keep your images in by right-clicking on the green folder and choosing **New Folder**. Rename it **Images**.

**Note:** Remember the 8 and 3 rule: keep the first part of your title to a maximum of 8 letters, and the **extension** (.htm) to 3. Although things may work if you break this rule, it can also cause problems in the future.

Notice how the titles of these pages are meaningful. If you title your pages 1.htm, 2.htm, it’s hard to remember what is in them, especially when you start adding many pages.

**Tip:** It’s a good idea to add an extra page called practice.htm. You can use this page to practice new things, as well as to store tables and other things so that you have a back up copy.

**.htm or .html?**

You have probably noticed that some webpages have the extension **.htm**, and others have **.html**. Either extension will work on most web servers. If not, you might have to change your extensions. Remember this if you have problems in the future for some reason. We will use **.htm** in this course.
Naming Images and Folders

Any image (picture, drawing, logo, etc.) and any folder MUST not have any spaces in the name. Also, the name should not be more than 8 letters. If it is an image, be sure to include the extension as well, for example .gif or .jpeg.

Correct way to name a folder:

- Images
- MyWebsiteImages

Wrong way to name a folder:

- My Website Images

Correct way to name an image:

- biglaugh.gif

Wrong way to name an image:

- big laugh.gif

Review

1. What is a Root Folder?
2. Why do you have to “define a site” before you start to make a new website?
3. What extension should all webpages have?
4. Should you have spaces in the names of folders or images?

Exercise

Add new pages to your website for each page that you have planned in your Storyboard.
Chapter 4: Text

The Property Inspector

To add words, simply type as you would normally. To change how the words look, highlight them and use the Property Inspector to alter them:

The Property Inspector will be your most useful tool in Dreamweaver. It will change depending on what you are trying to do. For example, if you are working with text, it will look like it does in the image above. If you are working with an image, it will change to show you information about that image.

Let's look at what each section of the Property Inspector does:

Text format and font style

The pull-down menu next to Format controls the size of text. For example, if you have a main heading, you can highlight your text and choose Heading 1 from the menu. For a subheading, choose Heading 2, etc.

Tip: I find Heading 1 to be quite large. I usually begin at Heading 2 and continue from there.

The second pull-down menu allows you to choose the font style of text. As mentioned above, it is best to use only one or two font styles on your website.
You will notice that each font selection doesn’t list just one font style, but three or four. This is in case your visitor’s browser version cannot use the first font style, in which case the second or third style will be used.

**Tip:** A good idea is to wait until you have finished a page, highlight it all, and **then** choose the font style. This will also help you remember not to use many different styles on one page.

### Font size

By highlighting text and then choosing a number from this pull-down menu, you can change the size of the text. The default (automatic) size is 3, so if you choose *none* or 3, there will be no change. If you choose 2, the text will be one size smaller. If you choose 4, the text will be one size bigger, etc. If you choose a number with a + or – sign in front of it, the size of the text will go that much larger or smaller than 3. For example, -1 will give you a size of 2.

**Tip:** I find the default size of font to be slightly large, so I have the text on my website in size 2.

**Tip:** Remember that text on Apple and Mac computers is a little smaller. You will need to test your site on a Mac to make sure people can still read it. Also, think about your audience. If they are older, you will need to make sure your text is large enough.
Text Color

To change the color of your text, highlight it and choose a color from this box. When you click on the box icon, this larger window will pop up with a choice of colors to choose from:

![Text color pallet.](image)

You can also type in the exact number of a color in the space next to it if you like. For a chart of colors available to you, check http://www.purplesunsetdesigns.com/Colortable.htm. Once you find a color you like, you can copy and paste the number of it into the space.

**Tip:** Remember to keep your colors easy to read. For example, don't choose a light color for your text if your background is light.
Bold and Italic

Bold and Italic

Just like a word processor, these allow you to bold and italicize your text.

Justify (Align)

Justify (Align)

These are options for aligning your text to the left, center, right or both right and left of your page. Remember to highlight your text before choosing one of these options.

Tip: Sometimes Dreamweaver might show text in a browser as centered or to the right when you didn’t ask it to do that. When that happens, simply highlight the text, right-justify it and then left justify it again.

Linking to other pages

Linking to other pages

This box is to allow you to create links using text or images on your page. You can link to either another website, or another page in your own site.

To link to another website:

1. Using a browser, go to the website you want to link to.
2. Go back to Dreamweaver and highlight the image or text you want to make the link to.
3. Copy and paste the address of the website into the box next to Link.
4. Hit F12 to preview test your page in a browser.

Tip: Remember that Dreamweaver is not a web browser, so you can’t click on the link in Dreamweaver. You have to use a browser to do that.
Open page in a new window

If you want to make the link open in another window, choose _blank from the Target pull-down menu.

**Tip:** To keep visitors from leaving your website when they click on a link to another website, use the _blank option. This will open a new window, keeping your website open on the first one. Don’t do this with links to other pages to your website.

Lists

Lists make things much easier to read. There are two types of lists you can make: **bulleted** and **numbered**.

To make an ordered or numbered list of your favorite food:

1. Type in the first word.
2. Choose ☐️ in the Property Inspector.
3. Hit <Enter>.
4. Continue to add each word to your list, hitting return after each one.
5. Press <Enter> twice to get out of the list mode.

Your list should look something like this:

1. Pizza
2. Ice cream
3. Fruit
4. Chocolate

To create an unordered or bulleted list, follow the same steps as above but use the ☐️ icon.
Nested lists

Nested means inside or indented. To create a nested list, or list inside a list, simply highlight the text you want to indent and click the indent icon. Here is an example of a nested list (a list within a list):

- Pizza
- Ice cream
- Fruit
  - Apples
  - Pears
  - Peaches
- Chocolate

Indents

These icons also allow you to indent or outdent text.

Inserting spaces

To add two spaces in a row: hold down the <Shift> key and the <Ctrl> key at the same time, and press the <Space> bar for each space you want.

Inserting paragraphs

To insert a paragraph, simply press <Enter>. This will create a blank line and start at the left side.

Moving to the next line without leaving a space

To move to the next line without leaving a blank space in between, hold down the <Shift> key as you press <Enter>.

Horizontal Line Breaks

To insert a horizontal line, go to the Insert menu and choose Horizontal Rule.
Changing Background Color

1. To change the color of the page background:
2. Go to Modify.
4. In the Page Properties box, click on the square next to Background:
5. Click on a color from the selection.
6. Click Apply.
7. Click OK.

Inserting Flash Text

Dreamweaver allows you to create text in Flash very quickly. The advantage of this is that you can choose from over 30 fonts. Normally you can only use about four because there are limited number of fonts that browsers can read: Times, Arial, Georgia, Verdana, etc. Another advantage is that you can make the color change when a person puts their mouse over the text.

To create text in Dreamweaver:
1. Put your pointer on your webpage where you want to insert the text.
2. Go to Insert.
3. Go to Interactive Images.
4. Choose Flash Text.
5. A box will open where you can now type in text. Type in some text, such as “Welcome!” in the big Text window.
6. Highlight your text, and from the Font pull-down menu select a font.
7. In the Size window choose a font size such as 16.
8. Next to Color, click on the box and select a color.
9. If you want the color of the text to change when you mouse over it, choose a rollover color.
10. Click OK.
11. Preview your changes in a browser by pressing F12. Move your mouse over the text to test your rollover color.

To edit or change your Flash text, simply double-click on the text and the Flash text editing box will open again.
Review

1. How do you insert more than one space in a row?
2. What happens if you hold down the <Shift> key and press <Enter>?
3. What Inspector will you be using most in Dreamweaver?
4. Why is it a good idea to use lists whenever possible?
5. What can you do to use a font on your page if it isn't a browser font?

Exercise

1. Double-click on your index.htm page and either type in some text or copy and paste some text from somewhere else. Practice changing the text size, color, alignment and style.
2. Make an ordered list of three items, such as your favorite websites. Test the links in a browser by hitting <F12> while in Dreamweaver.
Chapter 5: Saving, Previewing and Backing up

Saving your work

Be sure to save your page every few minutes and after every major change. To do so, go to File > Save, or hold down the <Ctrl> key and press S.

Previewing your work in a browser

To see how your webpage looks in a browser, press <F12> or File > Preview in Browser > IE.

Viewing the HTML code

As you type, Dreamweaver is creating the HTML code for you. To see it, click on the Code View icon at the top left of your page. You can edit the code directly in this window. To change back to the Design View, click on the icon.

Using the HTML code view, change one of the items on the list you just made and then see how it looks back in the Design View.

There are two things you should do to customize your view in the Code View window: turn on the Line Numbers and Word Wrap features. This will make it easier to view the HTML code. To do so:

1. Click on View.
2. Go to Code View Options.
3. Choose Line Numbers. You should see numbers appear down the left side.
4. Click on View again.
5. Go to Code View Options again.

To see both the Designer View and the Code View at the same time, click on the icon.
Adding a title to a webpage

Every page should have a title, for the following reasons:

• The title of the page shows up in the top left of the browser when a visitor views the page. If you forget to enter a title, they'll see "untitled document".

• When someone creates a shortcut or bookmark to your site, it will show the title of the page as the bookmark label.

• Some search engines will read the title of your page when they visit your site. If your title is descriptive, the search engines will rank your site higher.

To add the title to your page, simply type in a descriptive title in the box next to the title: [Untitled Document]. The more descriptive the title is, the higher your website will rank in the search engines, and the better people will be able to understand what your page is about. For example, if your website is an agency in Japan that finds ESL schools in Vancouver, you might have a title like this:

Vancouver English Abroad: A Japanese agency offering cheap English lessons, homestays, and ESL schools in Vancouver, Canada.
Chapter 6: Finding Images and Image Formats

Images such as drawings, logos and photos can make a site look much more interesting. They can also make a site load so slowly that visitors will leave before viewing the page.

Where to find images

An image can be a photograph, a drawing, or an animated graphic. There are several ways to get images for your website. These include:

- Using a scanner to convert one of your own photos to digital format.
- Capturing an image using a digital camera, video camera, or webcam.
- Buying collections of photos and clipart. A great collection of royalty-free photos is Hemera-Objects (a Canadian company) at http://hemera.com/products/products.htm. At their website you can get a free trial to test their product before deciding to buy.
- Downloading an image from any website. (Be sure to respect copyright.) To save a picture from a website using Internet Explorer, right-click on the image and choose Save Picture As…
- Using search engines to locate a certain image. (Be sure to respect copyright.) Some examples include:
  - Google (www.google.com/imghp)
  - AltaVista image search (www.altavista.com/cgi-bin/query?pg=q&stype=simage)
  - Fast Multimedia Search (http://www.multimedia.alltheweb.com/)
- Resourcing websites that sell images. Some websites sell professional-quality photos. Go to www.purplesunsetdesigns.com/imagesforweb1.htm#where for a list of such websites.
JPEG Vs GIF image formats

Images on a website are usually in one of two main formats: \texttt{.jpeg} (Joint Photographic Experts Group) and \texttt{.gif} (Graphic Interchange Format). If an image has just a few colors in it, such as 2 or 3, it should be in \texttt{.gif} format. Otherwise, it should be in \texttt{.jpeg}. Some images are also in \texttt{.bmp} format. It's best not to use the \texttt{.bmp} format because \texttt{.bmp} images are very large files.
The amount of information in an image is referred to the file size. This is measured in bytes (b), or kilobytes (k). A kilobyte is 1000 bytes.

Here are some examples. In the first table we see that a simple two-color image is much smaller in file size when it is \texttt{.gif} rather than \texttt{.jpeg}:

<table>
<thead>
<tr>
<th>Format</th>
<th>File Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{.gif}</td>
<td>1.5k</td>
</tr>
<tr>
<td>\texttt{.jpeg}</td>
<td>12k</td>
</tr>
<tr>
<td>\texttt{.jpeg}</td>
<td>6k</td>
</tr>
<tr>
<td>\texttt{.jpeg}</td>
<td>3k</td>
</tr>
</tbody>
</table>

You can see that the image in the \texttt{.gif} format is better quality while maintaining a smaller file size, less than 1.5 K. Even at 12 K, the \texttt{.jpeg} version is still lower quality.
.jpeg format: best for many colors
.jpeg is best for images with many colors, such as photos. Here is a comparison of a photo in both formats:

<table>
<thead>
<tr>
<th>.jpeg, 21k</th>
<th>.gif, 21k</th>
<th>.gif, 40k</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image-url" alt="Image" /></td>
<td><img src="image-url" alt="Image" /></td>
<td><img src="image-url" alt="Image" /></td>
</tr>
</tbody>
</table>

Here you can see how the .jpeg format is better at showing the complex colors of the food. At the same file size of 21k, the .gif image is low quality. Even at 40k, the .gif image is still not quite as good as the smaller .jpeg version.

**Tip:** Visit [www.purplesunsetdesigns.com/imagesforweb1](http://www.purplesunsetdesigns.com/imagesforweb1) to see how these pictures look on the Internet.
Ideal image file sizes

The amount of information in a picture or webpage is called the file size and is measured in bytes (e.g., 3000 bytes or 3k or kilobytes). Keeping the page file size small is an extremely important point that is often overlooked by web builders, many of whom have a high speed Internet connection. If your pages are more than 40 to 60k, they are not optimal in file size. It is usually the images on a webpage that increase the time it takes to view a page. Text takes almost no time to download.

The file size for a small image should be 5 to 10k. The file size for a larger picture might be 30k, but should be no bigger for use on a webpage. At 30k, an image will take 7 to 8 seconds to load for someone using a 56K modem Internet connection. If the total size of your webpage is over 40k, a visitor will have to wait 9 or more seconds to view the page. For most people this is too long, and they may leave your website and go to another one instead.

Tip: You can check the size of a complete webpage in Internet Explorer by going to File > Save As…. It will save the webpage to your Desktop in two parts: a folder containing the pictures and the html page. Highlight both parts, right-click and choose Properties. Check the size of images you see on websites. To do so:

1) Find an image you want to check.
2) Right-click on the image.
3) Choose Properties. You can now see the file size of the image, as well as its dimensions.

Exercise

1. Visit www.winzip.com. Estimate the file size of the main image. Then check and see if you were close.
2. Looking at the number of colors and the detail of the image, do you think it should be in .jpeg or .gif format?
3. Check the image information. What is its file size and format?
4. Try this with some other website images, such as those at www.cnn.com/ and www.cnet.com.
5. For an example of what happens when pictures are optimized improperly, visit this page of computer cases: http://www.atic.ca/store/product$/frameset.htm. How long did the page take to load? Check the file sizes and formats of some of the images.
6. On any website, find an image that is less than 10k.
7. Find an image that is more than 70k.
8. Find a .gif and a .jpeg image.
9. Find a webpage that is more than 100k.
10. Find a webpage that is less than 40k.
Review

1. What are the two main types of formats for webpage images?
2. If an image has just a few colors in it, what format should it be?
3. What format should be used for a photo of people?
4. How many k should a small image be?
5. How many k should a one webpage be, in total?
6. How long will it take to download an 80k webpage on a normal 56k modem?

Further resources:

- "Web Graphics Overview" at Webmonkey at [http://hotwired.lycos.com/webmonkey/01/28/index1a.html?tw=design](http://hotwired.lycos.com/webmonkey/01/28/index1a.html?tw=design)
- "GIF vs. JPEG" at Webmonkey at [http://hotwired.lycos.com/webmonkey/geektalk/97/30/index3a.html?tw=design](http://hotwired.lycos.com/webmonkey/geektalk/97/30/index3a.html?tw=design)
Chapter 7: Working with Images

Copying an image from a website

To copy an image from a website:

1) Find the image you want to copy.
2) Right-click on it.
3) Choose Save Picture As….
4) Change the name of the picture to something meaningful to you.
5) Browse to a location such as your Desktop and choose Save. I like to store images in a folder named Internet Images.

Note: Remember to respect copyright laws when using images. If the picture belongs to someone else, you should ask their permission before you use it. You could send them an email asking them if it’s ok to use it. If they give you permission, consider adding an acknowledgement of them on your webpage, including a link to their website.

Inserting images

1. Put your pointer where you want to insert the image on your website.
2. Go to Insert.
4. In the window that opens, browse to the image.
5. Double-click on the image once you find it.
6. Dreamweaver will warn you that the image is not in Dreamweaver, and it will ask you if you want to copy it there. Click Yes.
7. Open your images folder.
8. Rename your picture if you want to.
9. Choose Save.

Remember that the name of your picture should be no more than 8 characters long if possible, that the name should have no spaces between words, and that you have to include the proper extension (.gif or jpeg).
Changing image properties

In the image below, we see how the Properties Inspector changes depending on what you are doing in Dreamweaver. The image of the Canadian Flag has been selected so the Properties Inspector gives options for changing the image.

Changing the properties of an image
You can see a small version of the image on the left of the inspector, with the file size of the image next to it. In this case it is 2k.

**W:** Refers to the width of the image in **pixels**. Pixels are a kind of measurement unit, like centimeters. In the above example the width is 256 pixels.

**H:** The height is 180.

**Src:** (source) This refers to where the image is stored on your computer. If you want to link the image to another webpage, you can paste the URL in the box next to link.

**Link:** If you want to link the image to another page in your website, click on the yellow folder, browse to the page you want to link to, and double-click on that page.

**Alt:** (alternate text) This is the text that shows up in a little yellow box when you keep your mouse over a picture on a website. According to the ADA (American Disabilities Act), all websites should conform to this. An alt tag should contain a description of the image so it can be read by screen-reading software, which is used by blind people. Remember to always include the alt tags on every image.
**V Space and H Space:** This is where you can create a white space around the image.

**Border:** Create a black border around an image here.

**Align:** Move the image to the left, right or center of the page.

---

**Creating rollover images**

A rollover is an image that changes to another image when you move your mouse pointer over it. In order to make a rollover, you have to have two images that are either the same height and width or very close. To make a rollover:

1. Click on the **Insert** menu.
2. Go to **Interactive Images**.
3. Choose **Rollover Image**.
4. In the Insert Rollover Image box that comes up, put in a name next to **Image Name**. This name will not be visible on your website and is just so you know what this rollover will be called.
5. Next to **Original Image**, browse to and select the first image you want to show.
6. Next to **Rollover Image**, browse to and select the second image you want to show (it will show only when the mouse moves over the first image).
7. Leave the **Preload Rollover Image** option checked so both of the images will load automatically as the page first opens. This prevents a delay in having the picture change when someone puts their mouse over the image.

If you want your rollover to act as a link to another page when the image is clicked:

1. Copy and paste the **URL** (address) into the last box.
2. Click **OK** to close the box.
3. Hit `<F12>` to test the rollover image in a browser.
Chapter 8: Working with Images: Advanced

Thumbnails for visitor choice

The best way to display a large image on your website is to first make a smaller version of it (called a thumbnail image) and use the thumbnail as a link to another page that has the larger image on it. By showing a small version of your picture first, a reader has the choice of clicking on it or not, instead of being forced to wait for the large version to download. Include some instructions that will let the user know they can click on the image for a larger version. Also include information on the size of the larger image so they can decide if they are willing to wait for such a large image to load.

Creating a thumbnail takes a bit of extra work, but it's the only way to correctly show a large image without forcing people to wait. Here are the basic steps involved:

1. Create two versions of your picture: a small one that is about 10 to 15k in file size and anywhere from 100 to 200 pixels in dimension, and a large one that is about 40 k in file size and about 300 to 500 pixels in dimension.
2. Create a new webpage.
3. Insert your large image on this new page and label it.
4. Add some text below your large image saying something like "Back".
5. Link the text to the page the thumbnail will be on.
6. Add the thumbnail (smaller) image to the webpage.
7. Below it type something like "click for a larger image".
8. Link the thumbnail image and the text to the page with the larger image.
9. Test your links.

Tip: There is a quick, free and easy way to generate large numbers of webpages that have navigation links and thumbnail pictures. Use Web Album Generator at http://www.ornj.net/software/webalbum. You can customize the pages it generates in Dreamweaver.
Resizing and optimizing images

This section will explain how to use Adobe Photoshop to resize and optimize images for a website. We will also look at free web-based services that instantly optimize images. At the moment, there is only one way to optimize groups of pictures at the same time (batch optimization) and that is with Macromedia’s Fireworks. We will not be covering how to do that in this course.

Adobe Photoshop
You can get a free trial of this graphics software at: www.adobe.com/products/photoshop/main.html. However, you won’t be able to save anything you work on in this trial version. You’ll have to use a full version if you want to be able to save during your steps below.

Photoshop is the most popular software application for professionals for changing images. It costs about $1000.00 CDN. The answer to, "What exactly can I do to an image in Photoshop?" is "Anything". We don’t have to learn all the features of Photoshop at this time. Let’s just learn how to change the size of an image, and to optimize it for a webpage.

To change the size of an image in Photoshop:
1. Start up Photoshop.
2. Click on File at the top left.
3. Select Open.
4. Browse to the picture you want to work on and highlight it. You will then be able to see the picture at the bottom of this browsing window, along with its file size.
5. Click Open.
6. Now that your picture is open, click on Image on the top of the screen.
7. Choose Image Size. A window will open where you can change the size.
8. In the Pixel Dimensions section, choose a smaller width. By default the height will automatically adjust to keep the proportions relative.
9. Click OK.
10. If this new size is what you want, go to File and Save As your image under a different (and descriptive) name. If it isn’t what you want, go back to step 6.
To optimize an image for the web in Photoshop:

1. Open the image in Photoshop.
2. Click on **File**.
3. Choose **Save for Web**.
4. A window will open where you can choose 2-up or 4-up on the top right; this will change how many copies of the image you can view at once. Below each image will be what type of image it is (jpeg or gif), the file size in K, and the time it will take to download on a modem.
5. On the right you can use the pull-down menu to change the type of image from jpeg to gif. You can also change the quality of the image by choosing low, medium, high or a number. As you change these settings, you can see the effect on the images on the left.
6. Find a happy medium between the quality of the image and a fast download time.
7. Highlight the image you want to save.
8. Click **OK**.
9. On your computer, browse to the location where you want to save your newly optimized image (choosing the Desktop is an easy way to be able to find it again).
10. Change the name of the image to something descriptive.
11. Click **OK**.

**Online image optimizers**

If you are satisfied with the dimensions of your image but you want to reduce the file size, there are some free web-based services that help you do this:

- **NetMechanic** at [http://www.netmechanic.com/GIFBot/optimize-graphic.htm](http://www.netmechanic.com/GIFBot/optimize-graphic.htm). You can upload an image with this service as well as reduce an image already on the web. You also have the option to have the output in .jpeg or .gif format. The results tell you the percent the image has been reduced, as well as the new download time.
- **HitBox Central** at [http://www.hitbox.com/cgi-bin/page.cgi?tools/img](http://www.hitbox.com/cgi-bin/page.cgi?tools/img). You have to have your image already on a webpage to use this service.
Chapter 8: Tables

Inserting tables

Tables are a simple and powerful way to control the location of text and pictures on your website. They create a kind of framework on your webpage, making it easier to place text and pictures where you.

To insert a table into your webpage:

1. Go to the Insert menu.
2. Choose Table. The Insert Table dialogue window will open.
3. Next to Rows, insert 1.
4. Next to Columns, type 2
5. For Width, choose 50%.
6. Keep the Border number at one, or 0 if you want the border to be invisible when you view your webpage in a browser.

Changing the properties of a table.

When you highlight a table, the Properties Inspector gives you options for the table.

**Rows and Cols:** By changing these numbers you can add rows and columns.

**W and H:** Changes the width and height of the table. You have the option of choosing percent or pixels from the pull-down menu. It’s a good idea to keep your table’s width at 100%; this will cause the width to change according to the width of each visitor’s browser window.
**CellPad**: (cell padding) Creates a space between the table border and the text and images in the table.

**Align**: Allows you to left, right or center the table on the page.

**CellSpace**: Changes the space between the cells of the table.

**Border**: Changes the width of the outer border of the table.

**Bg Color**: Determines the color of the background of the table.

**Brdr Color**: Determines the color of the border, if you have set a border size greater than zero.

**Bg Image**: By clicking on the yellow folder you can browse and choose an image to show up as a background to the whole table. This will appear behind the text, so take care not to choose an image that is too busy, or too dark/light for the text.

**Exercise**

Insert a table on a practice page and make changes to the various sections described above. You can create an amazing variety of tables this way.
Chapter 9: Library Items and Templates

Creating Library items

The Library is a tool that allows you to create one copy of something and then use it again and again in different places in your website. For example, you could create a banner for the top of your webpage, add it to your library, and then just drag and drop that library item from the Library onto any other page.

One of the powerful things about library items is that, if you change the item in the library, Dreamweaver will update all copies of that library item on whatever pages you have them. This way, even if your webpage is 50 pages large, if you make one change to the library item, it will change on all 50 pages if you want it to.

What should you change to a library item? Anything that you will be using on many pages. For example, almost all of your pages will have the following:

- Banner or heading at the top of the page with the name of your website and maybe a picture, such as the following:

  **Vancouver English Abroad**
  
  *Jump into an English Speaking World!*

- A Navigation bar across the top, for example:

  - Steps
  - Vancouver
  - School Info
  - Apply
  - Get Ready
  - About Us

- You might also include a section at the bottom of every page to display copyright and email information.
Each of these items can be made into library items. To do so:

1. First create the item as you normally would in Dreamweaver.
2. From the top menus, select **Modify**.
3. Choose **Library**.
4. Select Add Object to **Library**.

A window will open, where you will see the item under **Library**.
Type the name of your library item where it says Untitled. Be sure the name you give it is descriptive.

Inserting Library items

To insert a library item that you have created:

1. Open your library (Window > Assets).
2. Drag and Drop the item’s green icon into your page.

Editing Library Items

To edit a library item:

Notice that when a library item is in your webpage it has a yellow background. This is to remind you that it is a library item and you cannot edit or change it in a webpage.

To make changes to a library item, right-click on the item and choose: Open Library Item…

Remember to save your library item when you finish making changes to it. When you do this, Dreamweaver will automatically offer to update all the pages in your website that have a copy of this item.

Visit http://vea6.tripod.com/ to see how the library items illustrated above are used on a website.

Creating a website template

Note: This section is not about using the Template feature of Dreamweaver.

Using a template is a way of saving yourself a lot of time and trouble whenever you want to add a new page to your site. It involves first creating a page that has everything that you want to appear on each page of your site, and then using this page as a basis for any new pages you create. This template page might include:
• Navigation (links to other pages)
• The name, graphic, or logo from your site
• A link to your email address
• Copyright information
• A background image you are using on each page
• A table that you are using to center content.

It might also include Library objects such as:
• The header or main banner of your site
• Navigation links
• The email address
• The copyright statement
• Logos.
• Any JavaScript code you want on each page, such as script to break out of frames or change the color of the scrollbars. (Go to www.purplesunsetdesigns.com/webcourse.htm to find links to JavaScript websites)
• Meta tag keywords and descriptions of your site.
• The page title

For an example of what such a template looks like, go to http://www.purplesunsetdesigns.com/anewpage.html. This is the template I use to add any new pages to my website.

To create a new page using a template, do the following:

1. In Dreamweaver, open the page that you’re using as a template (I call mine anewpage.html).
2. Go to **File**.
3. Choose **Save As**.
4. Give the page a meaningful title. For example, if your new page will be about pictures of your ski trip to Whistler, name it whistler.html.
5. Now you are ready to start inserting pictures or text on this page without having to set it up from the beginning.
Chapter 10: JavaScript and Other Extras

Including JavaScript code

JavaScript is a language that runs as a small program in a browser. JavaScript is used to add animation or other features to your site. Examples of what JavaScript can do are:

- Add to your webpages a date or time that is always current.
- Create a password-protected page.
- Animate pictures on your page.
- Detect the browser that a visitor is using and tell them.
- Welcome back a visitor if they have been there before.
- Break your site out of a frame (such as the Hotmail frame) if your site opens inside one.
- Change the color of the scroll bars down the right side of your page.

There are several sources of free pre-written JavaScript scripts or code on the Internet. These include:

- www.JavaScript Source.com
- http://html_help4u.tripod.com/effects.html

Visit www.purplesunsetdesigns.com/webcourse.htm for more websites that offer free JavaScripts.

In order to use these scripts, you usually have to copy the code and paste it into your webpage. Instructions are usually included at the site where you get the JavaScript. For example, here is how you can use the JavaScript codes that are found at www.jsfliers.com:

1. Go to www.jsfliers.com
2. Click on a link at the top, such as calendar, games, bg effects etc.
3. Read what each of them does. Sometimes you can test out the script on this page as well.
4. If it looks interesting and you want to add it to your site, click on Get Source Code.
5. Follow the directions in the box. There will be from one to three steps. Copy and paste the code directly into the HTML view of Dreamweaver.
6. Save (<Ctrl> + S) and preview (F12) your script in a browser (or follow their instructions if they are different from this).

Adding free, outside services to your site

Many services offer free features that you can add to your site. Some of these features include:

- Visitor counters (www.thecounter.com)
- Visitor trackers (www.hitbox.com)
- Live newsfeeds (www.moreover.com and headliner.net). (Moreover may have switched to a pay service)
- Messageboards (e.g., ezboard.com and infopop.com)
- Site search tools (www.atomz.com)
- Visitor polls (www.bravenet.com)

For more services go to http://www.purplesunsetdesigns.com/webcourse.htm.

Advantages of using these features on your site include:

- Many are free.
- They add interactivity.
- They don’t have to be maintained.

Disadvantages include:

- Takes time to find a service that you like.
- Takes time to customize.
- Advertising may be included.
- Services may stop at any time.

How to use these services

All of these services work the same way: you sign up for them, choose the features you want, and then copy and paste the code they give you into your webpage. You will find it easier to paste their code into an empty table so you can control the position of the code more easily. It’s also a good idea to paste a
backup copy into your practice page and save it. (I make a separate folder that I call Pages Working On for this.)
Chapter 11: Testing your Site

A very important final step before you officially publish your website is to test it thoroughly. This stage takes a lot of work and is often overlooked. Your website may look good to you on your computer, but it might look terrible on another computer with slightly different settings. The purpose of testing your site is to see how your website will look to all visitors, regardless of what computer or browser they are using.

As a rule, the less complicated you make your site, the more likely it will look consistent on different computer systems. Just because you can put something on your website does not mean you should. For example, if your site has a QuickTime video in it, many visitors will have to download the QuickTime plug-in for their browser before they can see the video. Many people won’t bother to do that.

The same goes for sound. Not everybody will have speakers installed and working on their computer, and their browsers may not support sound anyway.

Some people even turn off JavaScript in their browsers for security reasons. This means that any JavaScript in your browser will not show in their browser. Remember that when you use any JavaScript on your site.

Testing Checklist

Here is a list of what you need to check:

- All font styles and sizes are showing up properly.
- The contrast between your text color and background color is strong enough for the text to be readable.
- All images have alt tags.
- All words on every page are spelled correctly. To do this, go to Text > Check Spelling on each page.
- Pictures and text are aligned properly.
- Navigation is clear and easy to use.
- The names of your sections and headings are descriptive and meaningful.
- Visitors know what page they are on.
- All pages have page titles.
• Your HTML code throughout the site is accurate, has no incomplete tags, etc. You can check the code of your site using the Clean Up HTML feature. Find it under Commands > Clean Up HTML.

• All links on the site work, and they go where they are supposed to go. In the Site Map, go to File > Check Links. In the window that comes up, next to Show, choose External Links and click the green “play” button.

• Each page on your site has a small enough file size (and downloading time). You can see this information in the bottom right corner of each page. It tells you the file size and the number of seconds it will take to download on a 33k modem. (You can change the speed of the modem in Edit > Preferences > Validator.)

• The website looks good with different computer monitor resolutions, (800*600 and 1024*768). Check to see if you have used a font or image that looks too big or small, and that your tables are not too wide or narrow. To change the resolution of your monitor:
  1. Right-click on your Desktop.
  2. Choose Properties.
  3. Select Settings.
  4. In the Screen Resolution section, move the slider bar left or right.
  5. Click Apply and OK. Your screen will change. If it asks you if you want to keep that setting, choose Yes.
  6. Go back and look at your site under the new resolution.

• Your whole site works properly on both Netscape 4.x and 6.x and Internet Explorer browsers. To get these, go to www.tucows.com and do a search. Download and install these browsers and then visit your page.

• Have other people look at your website and ask them for advice.
Chapter 12: Registering your site with search engines

A critical part of getting your website online is submitting it to search engines. Search engines allow people to find your site easily. The higher your site ranks in a search engine, the more likely it will be that people will find your site. In fact, if your site ranks lower than the top 30 results then people will probably not find your site this way.

Wait until your website is almost completed before you submit it to search engines. This will ensure your site will be ranked as high as possible. Also, if you change the address (URL) of a page after you have submitted your website, the search engine may only give a link to the page that no longer works.

Search engines and directories

Strictly speaking, there is a difference between “Search Engines” such as Yahoo and Google. Yahoo, one of the oldest and most used services, has a directory and a search engine. In the directory, people have reviewed and ranked the websites. Google, on the other hand, indexes websites using a complex calculation that includes ranking a website according to the quality of the sites that link to it. Like Yahoo, Google is from Stanford University. At last count, their server farm consisted of at least 2400 computers, ensuring the fast results they are known for.

What search engines look for

Regardless of how the search engines work, there is no shortcut to getting ranked highly by them. Here is a list of factors that will increase the ranking of your website in search engines:

- Keywords (website descriptions) used in the meta tags. (See next section.)
- Density of keywords in the body text of your website.
- Proximity of keywords to the top of your pages.
- Alt tags and how they match your keywords.
- The Domain name.
- Number and quality of websites connecting to yours.
- The words in the page titles.
Meta tags

There are two types of meta tags that you need to add to your site: Description and Keywords.

The description is a summary of your website that people will see when they do a search on Google and your website comes up. It should quickly summarize the purpose of your website and be about 20 to 30 words in length.

The Keywords are words that people will use to search for your site. Use keywords that you think other people will use to find it. You can use about 20 to 30 keywords. Don’t repeat a keyword more than three times.

To add the description and keywords to go Insert > Head Tags > Description, or Insert > Head Tags > Keywords.

Find and Replace feature

This feature is a powerful and fast way to replace text or code on all of the pages on your website. It’s a great way to put meta tags on all your pages at the same time. Be very careful about using this feature because it can be hard to correct a mistake.

1. Go to Edit > Find and Replace.
2. Choose Entire Local Site.
3. Next to Search For, choose Code or Text.
4. In the next box, either type in, or cut and paste the text or code you want to replace.
5. Next to Replace With, type in the text or code you want to replace it with.
6. Click Replace All. (Or you can do the replacements one at a time by clicking Find Next and then Replace for each instance.)
7. Dreamweaver will warn you that changes cannot be undone in pages that are open. Click OK.
8. Check your pages to see that the changes took place.
Chapter 13: Website Promotion and Maintenance

Promoting your site

In addition to submitting your site to search engines, here are other things you can do to promote your website:

- **Buy a domain name** that is short and easy to remember, and host your website at that address. A domain name can be as cheap as $10.00 U.S. a year. Some sites such as Netscape will host your website free if you buy a domain name from them.
- Include your website address (and a logo if you have one) in your email signatures.
- Have your website address on your business card and letterhead.
- **Post** your website to message boards and lists that promote websites.
- Tell your friends, family and business associates.

Maintaining your Website

Once your website is created, there are some things you should do to keep the website looking fresh. This will encourage visitors to return, and allow you to keep up your web building skills:

- Improve the design and navigation as you learn what changes might be useful. Like writing, web publishing is a learning process that never ends. Once you finish a website, you will undoubtedly learn more about web building and want to improve your site.
- Try to add new, useful content.
- Update old content if it becomes out of date. Remember to change the front page and navigation to reflect any additions you have made to the site.
- Check all your links regularly to see if they are still working.
- Try to refresh the design by changing colors or pictures on your site.
- Resubmit your site to search engines occasionally. Twice a year is fine. Remember to use a false email address when you submit so you don’t start getting junk mail sent to your personal email.
Appendix

Web building vocabulary

Address: (n) Another name for this is URL. It refers to a location on the Internet. Example: the address of Yahoo is www.yahoo.com.

Bandwidth: (n) The speed of an Internet connection. 56K modems are low-bandwidth. DSL and cable connections are high bandwidth.

Domain name: (n) The name of a website. For example, the domain name of Yahoo is yahoo. If you want your own domain name, for example Yuki Satou, you need to buy yukisatou.com.

Download: (v) To get software or anything else from the Internet to your computer.

Extension: (n) The end of a filename; the part of the filename that comes after the dot. For example, the extension of a Word document is .doc. The extension of a webpage can be either .htm or .html.

Font: (n) The style of a word. For example, Arial or Times New Roman.

Format: (n) The way something is saved. For example, the format for images in webpages is usually .gif or .jpeg.

File: (n) This refers to almost anything on your computer. It can be a word document, a movie, or a webpage.

File size: (n) The measurement of how much information the file has contained in it. Not to be confused with height and width. For example. The file size of a small picture on the Internet should be about 10k.

Graphic: (n) A picture or drawing. Also called an image.

Hardware: (n) The part of a computer you can touch, for example the hard drive, the monitor, the keyboard, etc.

HTML: (n) HyperText Markup Language.

Host: (n) Another computer that stores your webpage so that people on the Internet can reach it. A host can be anywhere in the world.
**Home Page:** (n) Sometimes refers to a website, and sometimes to the first page of a website.

**Index:** (n) In web building, it is the name that the main page of your website must have. Be sure to call the first page of your website index.html. (v) to organize.

**Image:** (n) A picture or graphic.

**Image editor:** (n) Software that allows you to change an image. For example, you might want to make the picture smaller or change a color in it. Photoshop is an image editor, as is Paint.

**Java:** (n) A programming language that can, for example, allow you to play interactive games with other people on the Internet. It runs from the server (Internet) side.

**JavaScript:** (n) A small program that runs on the local (client-side) computer. It can tell you the date, or close windows, or allow you to see animations, etc.

**Nested:** (n) Inside. For example, nested tables are tables inside each other. You should avoid having more than 3 nested tables. (v) Nest: to put inside.

**Palette:** (n) A floating (moveable) window in Dreamweaver that allows you to choose options. The Properties Inspector is used more often than the others.

**Pixels:** Picture Elements. Dots that make up a computer or digitized image.

**Pointer:** (n) The arrow that represents your mouse on the screen.

**Post:** (v) Publish. When you transfer the webpage from your to the host server so that everyone on the Internet can see the changes.

**Publish:** (v) Same as post.

**Save:** (v) To keep a copy of what you are working on. You should save all the time--every couple of minutes--in case your computer crashes.

**Server:** (n) A computer that sends out information. A host server holds your webpage so that other people on the Internet can see it. (v) Serve: to send out.

**Server farm:** (n) A group of servers or computers. Google has a server farm of thousands of computers because so many people use their search engine.
**Search Engine:** (n) A service where you can find things on the Internet. Google.com is the best search engine, in my opinion.

**Software:** (n) The part of the computer you can’t physically touch. Software has instructions to tell hardware how to work.

**Root folder:** (n) The main folder of your website.

**Text:** (n) letters or words

**Usability:** (n) The area of concern in web design that is about making a webpage easy to use and ensuring that people can find what they want.

**URL:** (n) Universal Resource Locator. It is the unique address of any webpage on the Internet.

**Web building:** (n) Also called web publishing. Making webpages.

**Webpage:** (n) One page on a website. Sometimes also means a whole website.

**Web publishing:** (n) Same as web building. Making webpages.

**Website, Web site:** (n) A group of pages that has text and images that people can see on the Internet.

Webmaster, Web Builder, Webmistress, Web Publisher, Web Developer: (n) a person who makes webpages.

**WYSIWYG:** (n) What You See Is What You Get. An expression that describes when you're using a software tool that lets you make a webpage, and shows you exactly what the page will look like once you put it on the Internet.
Keyboard shortcuts

Dreamweaver has convenient keyboard shortcuts you can use to speed up your work. Here are the most important keyboard shortcuts:

- `<Ctrl>` **S**: *Save* current page
- `<Ctrl>` **C**: *Cut* text, HTML code or an image.
- `<Ctrl>` **V**: *Paste* text, HTML code or an image you have Cut.
- `<Ctrl>` **Z**: *Go back* one step. Great for taking back a mistake you’ve made. For going back many steps you might find it easier to use the History feature.
- `<F12>`: *Preview* the page you are working on in a browser.

FAQ: Frequently Asked Questions to common problems

**Q**: Why don't changes I make show up in when I Preview it?

**A**: Make sure you *save* your changes, and *refresh* your browser preview window.

**Q**: I'm trying to do something in Dreamweaver but it doesn't work. Is there something wrong with the program?

**A**: Probably not. Here are some things you can do to solve the problem:

- **Undo** what you did and do it over again. This might mean going back quite a few steps (use the History feature).
- Do the whole page over again.
- **Take a break** and return to the problem at a later time when you have a fresh perspective, in case you are overlooking something.
- Save your work and **restart** Dreamweaver. Although Dreamweaver is relatively stable, it is not foolproof. Sometimes it can freeze if there is not enough memory available on your computer. You might want to even restart your computer.
Q: One of my pictures is missing when I preview my page in a browser.  
A: Check to see the picture is actually stored where the path (i.e. Mysite/Images/Meatbeach.jpg) expects to see it. If all else fails, take out the picture and then reinsert it in your page and see if that solves the problem.

Q: One of my pictures is missing when I upload my website to the Internet and look at it.  
A: Check to see that you have uploaded the image to the Internet. If you have but you still can’t see the picture, go back into your webpage where the image is missing, delete the image and insert it again. Upload your page and check it again.
How to email webpages

A very useful thing to know is how to email a webpage. This allows you to either email a webpage to yourself, so you can get it to another computer, or send it to a friend.

In order to email webpages you should first zip them up. This will compact the information and keep it organized. The software to do this can be downloaded free from www.winzip.com. Windows XP also has zipping software included.

To zip your pages together:

1. If you are not using Windows XP, download the Winzip program and install it on your computer. If you have XP, you don’t have to do this.
2. Create a folder on your Desktop (right-click and choose new folder).
3. Name the folder something meaningful, such as “mywebsitejune”.
4. Drag and drop, or copy and paste the webpages you want to email into the folder.
5. Close the folder.
6. Right-click on the folder and choose either Send To and Compressed (zipped) Folder or choose the Winzip option.
7. Now you can compose an Email and attach this folder to it.
8. Send the Email.
Analyzing other Webpages

You can learn a lot by looking at how other webpages are created. By saving them and opening them in Dreamweaver, you can see the code and method that was used to create them. To do this:

1. Go to the webpage you want to analyze.
2. Go to **File** and choose **Save As**…
3. In the window that opens, browse to a location to save it in such as your Desktop.
4. Choose **Save**. The webpage will be downloaded onto your computer in two parts: a folder with the images, and the webpage itself.
5. In Dreamweaver, go to **File** and **Open**.
6. Browse to the webpage you have saved. The page will open in Dreamweaver. Now you can examine it and change it if you like.

Using Dreamweaver Help

In order to be able to find answers to problems that can arise, you can use the help feature included in Dreamweaver. Have a look at it now and practice looking up the answer to a problem. Let’s say you want to find out how to print out a copy of the keyboard shortcuts in Dreamweaver. To do so:

1. In Dreamweaver, go to the **Help** menu at the top right of a page.
2. In Help, choose **Using Dreamweaver**.
3. Click on **Search** in the window that opens.
4. In the small window that pops up, type in “**printing keyboard shortcuts**”.
5. Click on the **List Topics** button. You will get a list of all pages in **Select a topic to display**: that match your search (there should just be one result that shows up).
6. Click on the result to be able to read the information on the page.

Dreamweaver help is good for telling you how to do something in Dreamweaver, but it doesn’t tell you much about WHY you should do something.
Recommended Books

There are a number of good books on Dreamweaver. Here is a list of some good ones:

- **Visual Quickstart Guide: Dreamweaver.** The Visual Quickstart series is very good.
- **O'Reilly series.**
- **Sam's Teach Yourself** series of computer books

Other popular web building software

**Dreamweaver vs. FrontPage**

The most widely used WYSIWYG application is FrontPage by Microsoft. FrontPage's popularity is largely due to the fact it is bundled with the Microsoft Office application, and because people who are familiar with Microsoft products will find a familiar user interface in FrontPage. However, despite its widespread use, FrontPage has been plagued with problems throughout its various versions.

The biggest problem is that FrontPage tends to create extraneous and proprietary HTML code as you create Webpages with it. This results in slower-loading pages, or problems when someone tries to view your webpage in other browsers such as Netscape.

The second downfall of FrontPage is its complicated and restrictive workspace. It also uses a vocabulary that is confusing and counter-intuitive. For example, it calls a website a “web”, and if you want to post work live to the Internet it is called “save” rather than the more commonly used “publish” or “post”.

Another problem with FrontPage is that, in order to use some of the features it offers, you have to find a host that supports something called FrontPage Extensions. This means that your web host must run Microsoft software on their server. Some have argued that this requirement is another way for Microsoft to try to control the marketplace.

By using FrontPage, you could make a bad site easily, but people who want full control over what they create will eventually become frustrated as their web-building skills and website needs develop.
Dreamweaver, in contrast, has a very simple, intuitive workspace that allows a web builder maximum flexibility and control over what they want to create. It also produces the cleanest (i.e. most efficient) HTML code of any WYSIWYG. This is why Dreamweaver is the most popular choice among web-building professionals.

Other Web building editors

You can also create web sites with Adobe GoLive, Adobe PageMill, and even Microsoft Word and Corel Wordperfect. Dreamweaver has a feature in it that allows you to clean the messy HTML code that these products create.

Two simple, free applications that allow you make webpages are FrontPage Express and Netscape’s Composer. Visit my homepage for links to free tutorials for both. Although not as powerful as Dreamweaver, and with few of Dreamweaver's features, you can still create webpages with them.

Because all the different software products involved in web building can seem confusing to the beginner, here is an overview of the more popular software.

Fireworks

Macromedia, the producer of Dreamweaver, also makes an application called Fireworks. Fireworks allows you to optimize graphics for the Web, and create Javascript rollovers and menus in your web site. See the Images section for more on optimizing graphics. www.artbell.com and www.uwaterloo.ca are two examples of Javascript menus. As you put your mouse pointer over the links on the left of the page of these sites, more options appear. A drawback of this is that a visitor to the site does not know there are more options unless they move their mouse around the page to try to find them. Another problem with Javascript menus like this is that older browsers do not support them.
Flash
Also created by Macromedia, Flash allows you to create animation, much the same way cartoons are created. An excellent tool for creating artistic and creative sites, Flash must be used with caution from a web design point of view, since the flexibility of Flash has resulted in websites whose navigation is so “artistic”, that basic usability design principles have been ignored.

Image editing software

Photoshop
Created by Adobe, this is a powerful graphics manipulation application that allows you to alter every aspect of an image. In fact, there is almost nothing that you can’t do to an image with Photoshop. This is the industry standard, used by 80 to 90% of graphic professionals.

Paint Shop Pro
A smaller, less expensive, but nevertheless powerful alternative to Photoshop is Paint Shop Pro. Paint Shop Pro is shareware and is available at Tucows.

Paint
Another option is the free application Paint that comes with Windows. It is adequate for working with graphics. With it you can do simple cropping and editing of graphics, as well as save them in different formats. Paint won’t let you do some of the more sophisticated changes to images, such as adding drop shadows and filters. You will need one of these applications to properly prepare any graphics on your site, unless you have really good software that comes with your scanner, digital camera or graphics library.
A note to teachers

The purpose of this manual is not to teach how to give this course. However, I would like to share some things that have worked well with me in class:

- Make sure that students have the necessary computer background to be in this course. This includes:
  - Ability to use a web browser and find a website.
  - Understanding of directory concepts (e.g., how data is represented on a computer).
  - Ability to find things like a shortcut on their desktop.
  - Ability to create and open a new folder.
  - Basic keyboard ability, and ability to cut and paste text from one window to another.
- At the beginning of each class, review what you did during the previous class, ask if there are any questions, and preview what you are going to cover next.
- Use some chart paper and keep a running list of websites that you and your students have found useful for the course.
- Assess the level of your students, the priorities of your course, and time available, and spend an appropriate amount of time on the vocabulary. For example, I initially tried to elicit more vocabulary words from the students, but found it was too difficult for them to come up with a couple of words for homework. You might find this a good activity, however. You could also have them keep a journal of new words that they come across.
- Take advantage of the fact they have to create content for their website to help them with their writing skills. You could, for example, have them email their bios to another student for some peer editing.
- At the beginning of the course, get their email addresses and then send out an email to all the students with the addresses visible so they can start a kind of listserv among themselves. I also use these email addresses to help or remind students when they are falling behind or having trouble. I also make suggestions to students via email about their websites outside of class hours as I monitor their progress.
- Make sure students become familiar with the contents of this manual. If they keep asking the same question, you might refer them to this manual.
- Make sure all students are at least at the same stage so that a student doesn’t get behind and lost. You might find it helpful to pair stronger students with weaker ones so they can help each other.
- Make sure all students have a task. For example, if the task is to find and save three images for their website and one student finishes this quickly,
have them either help another student or go ahead and continue to find other images for their website.

- For students that are strong and can handle advanced ideas, have them read ahead in the manual or try some of the advanced sections in the appendix of this manual. Alternatively, have them continue to develop content as the other students complete a task.

- It is critical that students fully complete their storyboard and that you have reviewed it before they begin making their site. This will ensure they can properly visualize how their site will look and can focus on the technical aspects of creating the website instead of the content.

- I find it helpful to have the class make a circle with their chairs and take turns sharing how they feel about their websites, problems and concerns they have, questions they have, etc. It fosters a kind of cross-communication that isn’t possible when the students are at their computers, and gives me more of a sense of how the students are doing.

- Regarding the size of the website, I ask for 5 pages. However, if a student is capable and it is appropriate I suggest they add additional sections or content to their site.

- If a student is really struggling and needs further documentation or support, or if the student is really advanced, it may be helpful for them to purchase a textbook that fully details other aspects of Dreamweaver. See the Recommended Books section for titles.

- Please email me at scott@purplesunsetdesigns.com with any feedback or suggestions you might have. Email me if you want to check for a more recent version of this manual. http://www.purplesunsetdesigns.com/webcourse.htm for links to resources I use when I teach this course. Visit http://www.purplesunsetdesigns.com/webbuildingmisc.html for additional web building resources.

- Publish a website for the course that has links to all of the students' websites in the course. You can find my list on the top left of http://www.purplesunsetdesigns.com/webcourse.htm.